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Introduction
ELAN (EUDICO Linguistic Annotator) is an annotation tool that allows you to create, edit, visualize
and search annotations for video and audio data. It was developed at the Max Planck Institute for
Psycholinguistics, Nijmegen, The Netherlands, with the aim to provide a sound technological basis for the
annotation and exploitation of multi-media recordings. ELAN is specifically designed for the analysis of
language, sign language, and gesture, but it can be used by everybody who works with media corpora, i.e.,
with video and/or audio data, for purposes of annotation, analysis and documentation.

The annotation process involves three steps:

1. Defining tier types and tiers

2. Selecting time intervals

3. Entering annotations

This short guide is organized around these three steps and it will help you to understand and use the main
features and functionalities of ELAN.

1. ELAN installation, manual and website.
To install ELAN on your computer, go to the ELAN website http://tla.mpi.nl/tools/tla-tools/elan/ and follow
the instructions. On this web page, you will also find information about software and hardware requirements.
Be sure to download the manual too, it includes many details about the program which are not covered in
this getting-start guide. The full manual is available at : http://www.mpi.nl/corpus/html/elan/index.html

Alongside the manual, the website contains a Release History and Forum. You can reach both via Help >
Visit the ELAN website. This menu also lets you go to the Download Page to download a new version
or Subscribe to the mailing list. The Release History shows an overview of the differences between
the succeeding versions of ELAN and can be found online via: http://tla.mpi.nl/tools/tla-tools/elan/release-
notes.html.

2. Key concepts of ELAN

2.1. Annotation
An annotation is any type of text (e.g. a transcription, a translation, coding, etc.) that you enter on a tier.
It is assigned to a selected time interval of the video/audio file (e.g., to the utterance of a speaker) or to an
annotation on another tier (e.g., a translation is assigned to an orthographic transcription).

2.2. Tier
A tier is a set of annotations that share the same characteristics, e.g., one tier containing the orthographic
transcription, or another tier containing the free translation.

A tier can be `independent’ and `time-alignable’, in which case its annotations are directly linked to a time
interval of the media file (e.g., the `orthographic transcription’ tier). Or it can be `referring’, in which case it
is linked to another tier, its so-called parent tier (e.g., the `orthographic transcription’ tier is a parent tier of
the `free translation’ tier). The referring tier shares its time alignment with its parent tier. The annotations
of some referring tiers can be assigned to the time axis, but only to an interval that is contained within the
interval of their parent annotation.

It is possible to build nested hierarchies, e.g., the ̀ orthographic transcription’ tier is the parent tier of a ̀ word’
tier, and the `word’ tier is the parent tier of a `morpheme break’ tier.

http://tla.mpi.nl/tools/tla-tools/elan/
http://www.mpi.nl/corpus/html/elan/index.html
http://tla.mpi.nl/tools/tla-tools/elan/release-notes.html
http://tla.mpi.nl/tools/tla-tools/elan/release-notes.html
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2.3. Type
Tiers are assigned to tier types, which specify certain constraints. The following constraints exist: None
(independent, time-alignable tiers), Time Subdivision (the annotation on the referring tier can be subdivided
and linked to the time axis), Symbolic Subdivision (the annotation on the referring tier can be subdivided,
but not linked to the time axis), Symbolic Association (one annotation on the referring tier corresponds to
exactly one annotation on the parent tier).

2.4. Template
A template is a special ELAN annotation file, an “empty shell” that contains the tier setup for doing
annotations in a particular way, but without any annotations or attached media files. It saves a lot of work
to base a new annotation file on a template, and makes it easier to annotate several videos in the same way.

2.5. Annotation file (*.eaf)
An annotation file is the document that contains all the information about tiers (their attributes and
dependency relations), annotations, and time alignments and links to media files.

2.6. Media file (*.mpg, *.wav, etc.)
A media file contains the digitized video/audio (e.g. *.mpg) or only the audio (*.wav) data that you want
to annotate. It determines the time axis to which the annotation file (*.eaf) is linked.
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Chapter 1. Start a new annotation file
Every ELAN project consists of at least two files: one (or more) media file(s), and one annotation file.

1. One (or more) media file(s):

• zero or more video file(s) (*.mpg, etc.)

• and/or one audio file (*.wav)

The video file allows you to view the video and listen to the sound. If you want to view the waveform as
well, you need to create an additional *.wav file through a conversion program that converts the audio
data from one *.mp(e)g file into a *.wav format. In the case of multiple video files, the audio of
the first selected video file is played. The kind and number of supported video formats depend upon the
media framework you are using. If your media framework supports a format, the same goes for ELAN
in general.

2. One annotation file:

• an annotation file created by ELAN (*.eaf, “EUDICO Annotation Format”)

• or an imported annotation file.

All information (e.g., the tier setup, the time alignment, the annotations) is saved to the annotation file only
– never to the media file(s). So you don't have to worry that adding an annotation within ELAN will change
your media.

To start ELAN, do the following:

1. Double-click on the ELAN icon (on your desktop, or contained within the Java Web Start icon on your
desktop). The start window is displayed in which you can open different kinds of documents.

2. Click on the File menu.

3. Click on:

• Open... in case there is an ELAN file (*.eaf)

• New... in case there is a media file (e.g. *.mpg, *.wav), but no annotation file (*.eaf)

In this latter case, the New Transcription dialog window will be displayed, e.g.:
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Do the following:

1. Click on the "Look in" pull down box and browse to the directory that contains the media files.

2. If you want to use media files of another type (e.g. QuickTime *.mov), use the "Files of type"
dropdown menu > select QuickTime files. Whether a media type is supported depends on your software
configuration.

3. Double-click on the media file (*.mpg, *.wav, etc.) to select it. It appears now in the rightmost box.
Alternatively, you can select the media file name and click afterwards on the >> button.

4. If you want to use a predefined set of tiers (a template), select the Template radio button and choose the
template (i.e. *.etf) to be used:

5. Click OK to open the new annotation document; otherwise click Cancel to exit the dialog window
without creating a new file. An ELAN window containing the new document appears.
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Chapter 2. The ELAN window
The ELAN window displays the Menu bar, the Media Player controls, and a number of Viewers. The
following figure shows the different viewers and controls in the ELAN window:

• The Timeline Viewer shows the annotations. You can zoom in or out by right-clicking on this viewer
and choosing “Zoom”. The Timeline Viewer also shows annotations arranged on different lines, the tiers.
Each tier contains a different type of annotation, such as a section label, a free translation, a gloss, a
grammatical label, or a phonological feature such as eye blink or body shift.

• The location of the current frame is indicated in the Annotation Density Viewer and the Timeline Viewer
by the crosshair, a red vertical line or I-bar.

• The Grid, Text, and Subtitle Viewers provide alternative ways of viewing annotations on particular tiers.

2.1. Move around in the video/audio
An extended, VCR style set of media controls is available for starting and pausing the media player and for
stepping through the media. The steps are:

• 1 pixel of the Timeline viewer, defaults to 10 ms, depends on zoom level

• 1 frame, defaults to 40 ms (e.g. for audio)

• 1 second.

• 1 scrollview (of the Timeline viewer) or "page"
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• to the end/to the begin of the media

For all these steps there is a variant to the left and to the right.

The following picture shows the Media controls buttons together with their default short cut keys:

2.2. Control playback speed
On the Controls tab at the top of the ELAN window, next to the Grid, Text, and Subtitle Viewers, you can
adjust the rate at which the video plays, from very slow to twice normal speed. If your video includes audio,
there is also a volume control.

2.3. Set and use the selection
When referring to a selection in ELAN this is mostly about a selected time interval. Every audio and video
file has a time axis and it is possible to highlight a segment of it by creating a selection. The selection can
be used for creating new annotations or changing existing ones.

The most common way of creating a selection is by dragging with the mouse in any viewer area that has
a time ruler. While dragging the crosshair moves with the mouse and the video is updated constantly. The
begin, and end time of the current selection are displayed above the media and selection control buttons.
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When there is no selection it can be created by shift-clicking: a selection is created from the crosshair to
where there has been clicked. When there is already a selection, shift-click can be used to add to or subtract
from the selection.

Using selection mode in combination with the VCR style player buttons. In the example clicking the “1
second ahead “ button results in the selection being extended to the right with one second.

2.4. Using the selection controls
There are three Selection related buttons:

1. Play Selection, to only play the selected segment. In combination with Loop Mode the selection is

played multiple times. Use the Selection icon  from the selection controls, or use the shortcut
key SHIFT+SPACE.
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2.

Clear Selection, deselects the current selection. Use the Deselection icon  from the selection
controls, or the shortcut key ALT+SHIFT+C or ALT+C. You can also use the shortcut key CTRL+SHIFT+Z. This
shortcut also cancels selection mode.

3. “Move crosshair to the left/right boundary of the selection". Whether Selection Mode is on or off,

you can move the crosshair to the beginning  or end of the selection (Ctrl+/).

2.5. Working modes
There are several different working modes, some of which are designed with a specific task in mind. The
default mode is the Annotation Mode, a generic mode in which almost all functions are available. Most
functions discussed in this document so far are shown in the Annotation Mode. Switching between modes
can be done via the Options menu. The other modes are:

1. Synchronization mode:

The Synchronization Mode allows the user to synchronize media files (video, audio, time series) of
which the recording didn't’t start exactly at the same time. By setting an offset for some of the files in
this mode, the media files will be played in sync in ELAN. The media files will not be clipped, this
synchronization has only consequences while working with them in ELAN.

2. Transcription mode:
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The Transcription Mode is optimized for typing text into existing annotations. Annotations are presented
in a spreadsheet-like, tabular layout in which navigation (from one cell to another) is entirely keyboard
driven. When a cell (i.e. annotation) is activated the corresponding segment of the media starts playing.
The selection of the tiers that the user wants to be visible in the table is based on the type of the tiers;
tiers of the same type are shown in the same column. E.g. the first column can contain all tiers of type
“orthography“, the second column all tiers of type “translation” etc.

3. Segmentation mode:
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The Segmentation Mode is designed for rapid and easy creation of empty annotations while the media
is playing. Marking the begin and end time of annotations is done using the keyboard. It is possible to
change the boundaries of an annotation by dragging them with the mouse. Creating and changing the
boundaries of an annotation in this mode does not require making a time selection first (like is the case
in the Annotation Mode).

4. Interlinearization mode:
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Figure 2.1. Interlinearization mode Main view

Interlinearization mode is a text oriented mode designed for parsing and glossing annotations to one or
more lines of interlinearized text. This can be done manually or with the use of one or more so-called
Analyzers. Analyzers are software modules that accept an annotation as input and produce suggestions
for one or more annotations as output. Examples of the type of processing analyzers can perform
are tokenization, morphological parsing and lookup of glosses. The segmentation and (typically) the
transcription of speech events need to be done in one of the other modes before interlinearization can
be added in this mode.

Part of the user interface of this mode is a Lexicon panel, the front end of a Lexicon Component module. It
allows to create, import and edit a lexicon and its entries. Lexicons are stored separately from annotation
data in a new data format. These are the lexicons that analyzers can get access to.
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Chapter 3. Tiers, tier types, controlled
vocabularies and templates.

Every annotation in ELAN belongs to a tier. You can change what tiers you use, but to do so, you have to
understand how tiers work. Each tier shows as a separate row of annotations in the Timeline Viewer, and
is available for display in the Grid, Text, and Subtitles Viewers. Within a tier, annotations do not overlap,
but the annotations on one tier can overlap with annotations on other tiers. Every tier is classified as a
particular Tier Type. The tier type determines Whether the tier uses a Controlled Vocabulary. A controlled
vocabulary is a limited set of possible annotations that you can use in a tier. For example, a tier for eye gaze
might use a controlled vocabulary consisting of annotations such as “left”, “center” and “right”; these would
be the only possible values for annotations in this tier. If two or more tiers belong to the same tier type, they
may still differ from each other in several ways. They might:

• describe the behavior of different participants or different articulators of the same participant

• have different parent tiers

• use different default languages (English, Spanish, French, Chinese, etc.)

• use different conventions or styles (formal vs. informal glossing, for example)

So, for example, you might have a tier type of “Free translation” and have two different tiers, one for a
free translation in English and the other in Spanish. Or, you might have a tier type “handshape” with two
different tiers, one for each hand. Or, you might have a tier type “Note” and different tiers for grammatical,
ethnographic, and working notes. Thus, you have complete control over what tiers, tier types and controlled
vocabularies you use to annotate a particular video, how the tiers depend on each other, and how the tiers are
displayed. When you start work on a new video, it is helpful to base the annotation file on a template which
contains a predefined set of tiers, tier types, and controlled vocabularies (see ). But, there is often reason to
add new tiers or types, rearrange them, or make other changes. The following section explains how to do so.

3.1. Control how tiers are displayed
You can control which tiers are displayed and in what order. There are two ways to rearrange the order in
which tiers are displayed.

1. Right-click on the list of tiers and choose “Sort Tiers”, then choose which way you want them to be
grouped.

• “Sort by Hierarchy” displays relationships between parent and child tiers.

• “Sort by tier Type” and “Sort by Participant” group them according to tier type and participant.

• “Unsorted” leaves you completely free to rearrange the display as you want.

2. Click on the name of a tier and drag it up or down in the list. Depending on how you have chosen to
group the tiers, there are limits to how you can rearrange them. For example, if you have chosen “Sort
by Participant”, you can’t move a tier away from other tiers that have the same participant, but you can
move that participant’s group of tiers up or down as a group.

To hide or display a tier, right-click in the list of tiers at the left edge of the Timeline Viewer, choose Visible
Tiers, and then either Hide All, Show All, or choose which tiers to display with the check boxes.

If a tier has children, and you have chosen to sort the tiers by hierarchy, you can show or hide its children
as a group. Right-click on the name of the parent tier, and choose Collapse/Expand tiername.
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3.2. Create, modify and delete tiers
Before you create a tier, you have to have an appropriate tier type set up first. Furthermore, if you want to
use a controlled vocabulary with a tier, you can specify that in the setup of the tier type.

To add a new tier select Add New Tier from the Tier menu. The following Add Tier window will be
displayed, it shows an overview of the current tiers and a tab pane for adding, changing, deleting and
importing tier definitions.

The following attributes can be set for a tier:

• Name - should be unique in the set of tiers.

• Participant - name or code for the participant or subject this tier is referring to.

• Annotator - name or code of the creator of the annotations on this tier.

• Parent: the parent tier of this tier or none.

• tier Type - defines the type of this tier, the constraints that apply to it and its annotations.

• Default Language - in practice a property for input methods (virtual keyboard etc.).

To modify an existing tier, choose Edit, > Change Tier Attributes, or right-click on the name of the tier in
the Timeline Viewer and choose Change Attributes Of tier-name. Choose the tier you want to modify, make
changes, and choose Change. Some changes are not allowed, as they might invalidate existing annotations
on the tier. When you are done, choose Close.
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To delete a tier, choose Edit, > Delete Tier, or right-click on the name of the tier in the Timeline Viewer and
choose Delete tier-name. Choose the tier you want to delete, and then choose Delete. This will delete the
tier along with any annotations that are on it. When you are done with deleting tiers, choose Close.

3.3. Create, modify and delete tier types
A tier type consists of a number of constraints that can be applied to a tier and its annotations. Several
predefined structural relations and constraints are available. A tier has to be associated with a tier type and
is thus assigned to a certain type of linguistic data, for instance orthography, translation, part of speech,
gesture phases etc.

To add a new tier type select Add New tier Type from the Type menu. The window shows a table with the
current types and a tab pane for adding, changing, deleting and importing type definitions.

The following attributes can be set for a tier type:

• Name - should be unique in the set of types

• Stereotype - None or one of four constraint types (see below)

• Controlled Vocabulary - none or one of the available controlled vocabularies

• ISO Data Category - the identifier of a data category in ISOcat

• Time-alignable - depends on the selected Stereotype, can not be set by the user
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• References to Graphics Allowed - to be ignored, leave this box unticked

To modify an existing tier type, choose Edit, > Change tier Type. In the drop-down box, choose what type
you want to change, make the changes, and choose Change. Then, repeat the process with other tier types.
Some changes are not allowed, as they might invalidate existing annotations on the tiers. When you are
done, choose Close.

To delete a tier type, choose Edit, > Delete tier Type. In the drop-down box, choose which type you want to
delete, then choose Delete. Be careful not to do this until you first make sure that there are no defined tiers
that belong to this type! When you are done, choose Close.

3.3.1. Tier hierarchies
Tiers can be set up as a child tier or dependent tier of another tier. Annotations on a dependent tier each
are bound to an annotation on the parent tier, the time boundaries of the child annotation cannot exceed the
boundaries of the parent annotation. In other words, the child annotations are always required to be inside
the interval of the parent annotation. To create a dependent tier, first make sure a tier type with a proper
Stereotype has been created: “None“ is exclusively for tiers without a parent, the other types are only for
depending tiers. In the Add Tier window, first select the parent tier for the new tier and then select one of
the available valid tier types. The Stereotype of the tier type determines the kind of annotation that can be
created on the tier. As long no parent tier has been selected only the tier types with Stereotype “None” are
listed. A few additional constraints apply when setting up tiers:

• A tier of a “symbolic“ Stereotype (Symbolic Subdivision, Symbolic Association) can not have a child tier
of a time-alignable type (Time Subdivision, Included In).

• Once a tier has been created and contains annotations, it is not possible anymore to change its tier type
to a type with another stereotype.

The following table list the four currently available stereotypes and their main features:

Table 3.1. tier type stereotypes

• None The annotation on the tier is linked directly to
the time axis, i.e., the annotation is entered on an
independent tier. Two annotations cannot overlap.

• Time Subdivision The annotation on the parent tier can be sub-divided
into smaller units, which, in turn, can be linked
to time intervals. Note that there are no time gaps
allowed, i.e., the smaller units have to immediately
follow each other.

E.g., an utterance transcribed on a parent tier can
be sub-divided into words – each of which is then
linked to its corresponding time interval. Annotations
on such tiers are time-alignable. They differ from
annotations on independent tiers in that they are
assigned to an interval that is contained within the
interval of their parent annotation.

• Symbolic Subdivision Similar to Time Subdivision, except that the smaller
units cannot be linked to a time interval.

E.g., a word on a parent tier can be sub-divided into
individual morphemes (which are not linked to a time
interval).

• Included In
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All annotations fall within the borders of the parent
tier. However, there can be gaps between the child
annotations.

E.g., a sentence with a silence can be split up into
words while the silence corresponds to a gap in the
child annotations (i.e. the separate words).

• Symbolic Association The annotation on the parent tier cannot be
sub-divided further, i.e., there is a one-to-one
correspondence between the parent annotation and its
referring annotation.

E.g., one sentence on a parent tier has exactly one
free translation. Or one word has exactly one gloss.

3.4. Create and modify controlled
vocabularies

A Controlled Vocabulary is a list of possible annotation values (or codes) that the annotator wants to use on
one or more tiers. CV’s can be created and modified by the user and can be part of the annotation document
or can be defined in a separate file. CV’s can reduce typing errors and thus improve annotation consistency.
CV's give you a way of using a restricted set of labels for the annotations on one tier. This both gives
consistency to your annotations and makes it faster to add them. They are especially useful for annotations
of phonological features, such as eye gaze, blinks, mouth shape, body shift, and so forth. You establish a
controlled vocabulary for a tier indirectly, by associating it with the tier’s tier type. So, to use controlled
vocabularies, first you have to set up the controlled vocabulary itself, then set up a tier type that uses it, then
set up a tier that belongs to that tier type.

To define a new Controlled Vocabulary or change an existing one select Edit, > Controlled Vocabularies
in the Edit menu.

The Edit Controlled Vocabulary window consists of two main parts. The upper part is for adding, importing.
exporting and changing the vocabularies. The lower part of the window is for adding and modifying the
entries of the selected controlled vocabulary. An entry consists of a value and an optional description. Apart
from that it is possible to link an entry to a data category defined in ISOcat.
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Figure 3.1. Edit controlled vocabulary

1. The CV being edited , the entries and the set language.

2. Import & export options, link to an external CV.

3. Annotation value as it is going to be filled in.

4. A description of the entered value.

5. Association with an ISO Data Category.

6. Buttons to move the selected entry up/down, top/bottom. Undo/redo changes to the CV.
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There is also an option to set one or more languages for a CV. This allows you to have one CV that contains
a certain vocabulary in both English and German, for instance. You can choose from nearly 7700 ISO
specified languages.

Figure 3.2. Edit CV Languages

1. The list of current languages linked to the CV

2. Entries for the linked languages

3. Annotation value and description as it is going to be filled in.

4. Add/change/delete entries within the chosen language.
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When a tier has been associated with a controlled vocabulary (via its tier type), a drop down list appears the
moment an annotation on that tier is created or edited allowing the user to select one of the values.

3.5. Create and modify a template
Once you have a set of tiers, tier types, and controlled vocabularies that you like, you can save them in
a template so that you can use them later for creating new annotation files. A template is an annotation
document without links to media files and without annotation but with the definitions tiers, tier types and
controlled vocabularies. It can be created from any annotation document and can be used as the basis for new
annotation documents. To create a template chose File, > Save as Template.... The extension for template
files is .etf. To create a new annotation document based on a template, follow the steps to create a new
document. In the File browser, click the Template button and navigate to a folder containing a template file.
Select the .etf file and click the “copy to right” button >> or double-click the template file. The right panel
now lists a template file and the selected media file(s) for the new document. A new document is created
with the media player(s) and all the tiers from the template.

Note

Any changes to the template will not affect any annotation files already created. This can be
good and bad: good when you want to revise the template without affecting annotation files
you’ve already created, bad when you want to make the changes in the annotation files too. In
the latter case, you will need to make the changes individually in each file.
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Chapter 4. Work with annotations
This section explains how to add annotations to a tier, to use them once they are added, and to modify them.
This is the heart of what ELAN is designed to do and what makes it so tremendously useful.

4.1. Add an annotation

4.1.1. Entering annotations (into the Inline Edit box)
How to create an annotation depends on the type of the tier the annotation has to be added to. On time-
alignable tiers new annotations (usually) are created with a specific begin and end time. On non-alignable
tiers annotations inherit time information from a parent annotation that they depend on.

Select a tier to work with as the “Active Tier”. The easiest way to do this is to double-click on the name of
the tier, at the left side of the Timeline Viewer. The name of the active tier will be underlined, red and bold.
When a portion of the video is selected, the shading of the active tier inside the selection is pink rather than
blue. The active tier is the one that normally receives new annotations.

A time-alignable annotation can be created on the junction of a selection and the active tier. There are several
ways to do so:

• In the Annotation menu select New Annotation Here

• Right click on a tier and from the popup menu select New Annotation Here

• Double click in the area where a selection and a time alignable tier intersect

In all cases, the Inline Edit box appears, e.g.:

The same text edit box appears when double clicking an existing annotation. An alternative method to get
an Inline Edit box is the following:

1. Click a time that should become the begin time of the annotation.

2. Press SHIFT+ENTER.

3. Click a time that should become the end time of the annotation.

4. Again press SHIFT+ENTER.

An Inline Edit box appears on the selected tier.

You can now enter an annotation value and then press the key ESC to commit the text. If you press the keys
CTRL+ESC (without entering an annotation value), you create an empty annotation. To save the annotation
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you can either use the shortcut keys CTRL+ENTER, or right-click in the Inline Edit box and click on Commit
Changes in the pull-down menu.

4.1.2. Entering annotations (into the Edit Annotation
box)

The Edit Annotation window differs from the Inline Edit box in that it has a bigger, resizable display and
supports line wrapping. It is therefore better for entering longer texts.

To enter an annotation into the Edit Annotation box, do the following:

1. Either make a selection in the Timeline Viewer, or click on an existing annotation in the Timeline or
Interlinear Viewer.

2. Access the Inline Edit box

3. Do one of the following:

a. Either use the shortcut keys SHIFT+ENTER.

b. Or right-click in the Inline Edit box. A pull-down menu appears. Click on Detach Editor.

4. The Edit Annotation box appears:

The Edit Annotation box is automatically preconfigured for the default character set of the tier. If you
want to use a different character set, do the following:

a. Click on Select Language. A pull-down menu appears that displays the available character sets,
e.g.:
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b. Click on the appropriate character set. From now on, the characters are entered in the selected set.

c. To switch back to the default character set, repeat the steps above and select the default set from
the pull-down menu.

5. Edit the annotation.

6. Save the annotation by doing one of the following:

a. Use the shortcut keys CTRL+ENTER.

b. In the Edit Annotation box, click on Editor and then click on Commit Changes in the pull-down
menu.

To exit the Edit Annotation box without saving, do one of the following:

1. Use the shortcut key ESC.

2. In the Edit Annotation box, click on Edit and then click on Cancel Changes in the pull-down menu.

To return to the Inline Edit box, do one of the following:

1. Use the shortcut keys SHIFT+ENTER.

2. In the Edit Annotation box, click on Attach Editor in the pull-down menu.

4.2. Modify or delete an annotation value
To modify the text of an existing annotation, first make it active. Then, you can do one of the following:

1. In the Timeline or Interlinear Viewer:

a. Click on the annotation that you want to modify. It appears in a dark blue frame which means that
it is active. You can only edit active annotations



Work with annotations

27

b. Do one of the following:

i. Right-click on the selected annotation. A pull-down menu appears. Click on Modify annotation
value.

ii. Or click on Annotation > Modify annotation value (ALT+M).
The Inline Edit box appears.

2. In the Grid Viewer:

a. Double-click on the annotation that you want to modify.
The Inline Edit box appears.

To delete the value of annotation, do the following:

1. In the Timeline or Interlinear Viewer, click on the annotation from which you want to delete the value.
It appears in a dark blue frame.

2. To delete it, do one of the following:

a. Right-click on the selected annotation. A pull-down menu appears. Click on Remove Annotation
Value.

b. Or click on Edit menu. Then click on Remove Annotation Value.

c. Or use the key equivalent ALT+Delete.
The annotation value is deleted without further warning

4.3. Subdivide an annotation on a depending
tier

Annotations on some tiers can be subdivided into smaller units on a depending tier. In this way, you can
for example break up a sentence into different words (or words into morphemes, etc.), as in the following
illustration:

To divide an annotation into smaller units on a depending tier, do the following:

1. In the Timeline or Interlinear Viewer, click on the annotation that you want to subdivide. It appears in
a dark blue frame.

2. Do one of the following:

a. Right-click on the selected annotation. A pull-down menu appears. Click on either New Annotation
before or on New Annotation after to subdivide the annotation.



Work with annotations

28

b. Or click on Edit menu. Then click on either New Annotation before or on New Annotation after
to subdivide the annotation.

If you click on New annotation before, the original annotation is divided and the new annotation is
inserted to its left (as in the illustration below). If you click on New annotation after, it is inserted
to its right.

Note

This option is only available for those tiers that are assigned to the stereotypes Time
Subdivision and Symbolic Subdivision.

An annotation is always subdivided into two units. If you need further subdivisions, repeat the steps above.


